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1 Einleitung 
Der Ozon-Tester Aeroqual ist ein hochgenaues Messgerät zur Messung der Ozonkonzentrationen in 
unserer Umluft. Der Ozon-Tester Aeroqual kann mit einem von vier, sich in dem Messbereich 
unterscheidenden, Sensorköpfen bestückt werden. Die Einsatzmöglichkeiten des Ozonmesser Aeroqual 
erstrecken sich innerhalb der Industrie auf Betriebe der Papier-, Textil-, oder Schmierstoffherstellung die 
in ihren Prozessen zum Bleichen von Ölen, Fetten, Wachs, Papier, synthetischen Fasern, Zellstoff oder 
Textilien Ozon verwenden. Einen weiteren Einsatzbereich findet der Ozontester Aeroqual nach und 
während Reinigungsarbeiten, Desinfektionsarbeiten und Entkeimungsarbeiten die z.B. in 
Schwimmbädern Wasseraufbereitungsanlagen oder nach Brandschäden und Wasserschäden mit Ozon 
durchgeführt werden. Mit dem Sensorkopf für den unteren Messbereich bis 0,150 ppm können Ozon 
Konzentrationen gemessen werden die auf die Befindlichkeit des Menschen negativ wirken. Durch die 
Verwendung führender GSS Technology Sensoren hat der Ozonmesser Aeroqual eine hohe 
Messgenauigkeit sowie eine sehr lange Lebensdauer der Sensorköpfe. Die einzigartige Möglichkeit die 
Sensoren zu refreshen, bietet gegenüber anderen Sensor-Technologien, eine kostengünstige 
Unterhaltung der Geräte. Je nach Model können die gemessenen Konzentrationen über eine analoge 
Schnittstelle mit einem 0…5 V Ausgangsignal ausgegeben, in dem internen Speicher geschrieben oder 
über eine RS232 Schnittstelle zu einem PC übertragen werden. Durch die Einfachheit der Bedienung 
können in kürzester Zeit die Alarmschwellen für die optische oder akustische Signalisierung verändert 
werden. Auf dem LCD Display werden neben den gemessenen Konzentrationen, die in ppm oder mg/l 
angezeigt werden, auch die hoch und tief Alarme dargestellt. 

1.1 Lieferumfang 

1 x Basisgerät Serie 300/500   
1 x Sensorkopf 
1 x 12 V DC 800 mA AC/DC Steckernetzgerät 
1 x Bedienungsanleitung 
1 x Akkupack 9,6 V Serie 300/500 
1 x Software und Datenkabel (USB) (nur bei Serie 500) 
 

2 Sicherheit 
 
Bitte lesen Sie vor Inbetriebnahme des Gerätes die Bedienungsanleitung sorgsam durch. Schäden, die 
durch Nichtbeachtung der Hinweise in der Bedienungsanleitung entstehen, entbehren jeder Haftung. 

2.1 Warnsymbole 

 

Allgemeine Warnung.  
Ziehen Sie unbedingt die Dokumentation zu Rate.  

 

Betriebsspannung unter Sollwert.  
Batterien auswechseln, sonst Fehlmessungen möglich 

2.2 Warnhinweise 

 Dieses Messgerät darf nur in der in dieser Bedienungsanleitung beschriebenen Art und Weise 
verwendet werden. Wird das Messgerät anderweitig eingesetzt, kann es zu einer Gefahr für den 
Bediener sowie zu einer Zerstörung des Messgerätes kommen. 

 Gerät keinen extremen Temperaturen, direkter Sonneneinstrahlung, extremer Luftfeuchtigkeit 
oder Nässe aussetzen. 

 Das Öffnen des Gerätegehäuses darf nur von Fachpersonal der PCE Deutschland GmbH 
vorgenommen werden. 

 Das Messgerät darf nie mit der Bedienoberfläche aufgelegt werden (z.B. tastaturseitig auf einen 
Tisch). 

 Benutzen Sie das Messgerät nie mit nassen Händen. 

 Es dürfen keine technischen Veränderungen am Gerät vorgenommen werden. 

 Das Gerät sollte nur mit einem feuchten Tuch gereinigt werden. Keine Scheuermittel oder 
lösemittelhaltige Reinigungsmittel verwenden. 
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 Das Gerät darf nur mit dem von PCE Deutschland angebotenen Zubehör oder gleichwertigem 
Ersatz verwendet werden. 

 Vor jedem Einsatz dieses Messgerätes, bitte das Gehäuse auf sichtbare Beschädigungen 
überprüfen. Sollte eine sichtbare Beschädigung auftreten, darf das Gerät nicht eingesetzt 
werden. 

 Weiterhin darf dieses Messgerät nicht eingesetzt werden wenn die Umgebungsbedingungen 
(Temperatur, Luftfeuchte …) nicht innerhalb der in der Spezifikation angegebenen Grenzwerten 
liegen. 

 Setzen Sie den Sensorkopf (nur Ozon) keiner übermäßig hohen Ozonkonzentration aus. Das 
Gerät ist für übliches Umgebungsklima, nicht für direkte Ozonströmungen ausgelegt. 

 Das Messgerät darf nicht in einer explosionsfähigen Atmosphäre eingesetzt werden. 

 Wenn die Batterie leer ist, (wird z. B. durch den Batterieindikator angezeigt) darf das Messgerät 
nicht mehr verwendet werden, da durch falsche Messwerte Lebensgefährliche Situationen 
entstehen können. Nachdem wieder volle Batterien eingesetzt wurden, darf der Messbetrieb 
fortgesetzt werden. 

 Vor jedem Einsatz bitte das Messgerät durch das Messen einer bekannten Größe überprüfen. 

 Die in der Spezifikation angegebenen Grenzwerte für die Messgrößen dürfen unter keinen 
Umständen überschritten werden. 

 Wenn das Messgerät über eine längere Zeit nicht eingesetzt werden soll, entfernen Sie bitte die 
Batterien, um eine Beschädigung durch ein Auslaufen der Batterie zu vermeiden. 

 Bei Nichtbeachtung der Sicherheitshinweise, kann es zur Beschädigung des Gerätes und zu 
Verletzungen des Bedieners kommen 

 
Bei Fragen kontaktieren Sie bitte die PCE Deutschland GmbH. 
 
 

3 Spezifikationen 
 

Messeinheiten ppm oder mg/m³ 

Spannungsversorgung  
 

9,6 V Akkupack  (2100mAh, Ni-MH) oder Netzgerät  
(12 V DC, 800 mA) 

Schutzklasse  IP 20 

Gewicht (inkl. Sensorkopf und Batterien) Ca. 460 g 

Abmessungen  195 x 122 x 54 mm 

Lagertemperatur ≥ 10 °C 

Betriebstemperatur -5 °C ... 50 °C 

Batteriestandsanzeige Symbol im Display 

Steuerungsausgang 
Unbedingt Diode verwenden! (siehe Kap. 5.4.1) 

12 VDC oder Schalter zu Masse (max. 150 mA) 

Analogausgang  0 – 5 V  
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3.1 Spezifikationen der Sensorköpfe 

Sensor Kali-
brierter 
Bereich 

Höchst- 
belastung 

LDL Genauigkeit Auflösung Ansprech- 
zeit 

Sampling-
methode 

Betriebs- 
temperatur 

Maximale relative 
Feuchtigkeit 
 im Betrieb 

Ammoniak 
0 .. 100 ppm 

0 ... 100 200 0,5 ppm < ± 5 ppm 0,1 ppm < 60 s F -20 °C ... 40 °C 5 ... 95 % 

Ammoniak 
(Leck) 
0 ... 1000 ppm 

0 ... 1000 2000 2 ppm  < ± 15 % 1 ppm < 60 s F -20 °C ... 40 °C 5 ... 95 % 

Kohlenmonoxid 
0 ... 100 ppm  

0 ... 100 200 0,5 ppm < ± 5 ppm 0,1 ppm < 150 s F 0 °C ... 40 °C 5 ... 95 % 

Kohlenmonoxid 
0 ... 1000 ppm 

0 ... 1000 2000 1 ppm < ± 10 ppm 1 ppm < 150 s F 0 °C ... 40 °C 5 ... 95 % 

Kohlendioxid 
0 ... 2000 ppm 

0 ... 2000 NA - < ± (40 ppm + 3 %) 10 ppm < 60 s F 0 °C ... 40 °C 5 ... 95 % 

Kohlendioxid 
0 ... 5000 ppm 

0 ... 5000 NA - < ± (150 ppm + 5 %) 10 ppm < 60 s F 0 °C ... 40 °C 5 ... 95 % 

Kohledioxid 
0 ... 5 % 

0 ... 5 % NA - < ± 5 % 0,01 % < 60 s F 0 °C ... 40 °C 5 ... 95 % 

Wasserstoff 
0 ... 5000 ppm 
(1) 

0 ... 5000 20000 5 ppm < ± 10 % 1 ppm  < 90 s F -20 °C ... 40 °C 5 ... 95 % 

Schwefelwasser-
stoff 
0 ... 10 ppm 
(1) 

0 ... 10 25 10 ppb < ± 1 ppm (0-10 ppm) 
< ± 2 ppm (10-50 
ppm) 

0,01 ppm < 60 s D -20 °C ... 40 °C 5 ... 95 % 

Schwefelwasser-
stoff 

0 ... 50 100 0,05 ppm < ± 15 % 0,1 ppm < 60 s D -20 °C ... 40 °C 5 ... 95 % 
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0 ... 50 ppm 

Methan 
0 ... 10000 ppm 

0 ... 9999 10000 - < ± 15 % 1 ppm < 60 s F 0 °C ... 40 °C 30 ... 80 % 

Ozon 
0 ... 0.150 ppm 

0 ... 
0,150 

0,250 1 ppb < ± 0,005 ppm 0,001 ppm < 70 s F -5 °C ... 40 °C 5 ... 95 % 

Ozon 
0 ... 0,5 ppm 

0 ... 
0,500 

1 1 ppb < ± 0,008 ppm  
(0 ... 0,1 ppm) 
< ± 10 % 
(0,1 ... 0,5 ppm) 

0,001 ppm < 60 s F -5 °C ... 40 °C 5 ... 95 % 

Ozon (2) 
0,5 ... 20 ppm 

0,5 ... 20 25 10 ppb < ± 10 % 
(0,5 ... 2 ppm) 
< ± 15 % 
(2 ... 20 ppm) 

0,01 ppm < 35 s F -5 °C ... 40 °C 5 ... 95 % 

Ozon 
(Leck) 

Für die Detektion von Lecks bei IDLH-Referenzwert 5 ppm  
(IDLH = Immediately Dangerous to Life & Health) 

0,01 ppm < 10 s F -5 °C ... 40 °C 5 ... 95 % 

NMHC (3), (4) 
0 ... 25 ppm 

0 ... 25 50 0,1 ppm < ± 10 %  
(0,1 ... 25 ppm) 

0,1 ppm  < 60 s F -20 °C ... 40 °C 5 ... 95 % 

Perchlorethylen 
0 ... 200 ppm 

0 ... 200 250 1 ppm < ± 5 ppm 
(0 ... 50 ppm) 
< ± 10 % 
(50 ... 200 ppm) 

1 ppm < 5 s F 0 °C ... 40 °C 5 ... 95 % 

Schwefeldioxid 
0 ... 10 ppm 

0 ... 10 20 0,2 ppm  < ± 0,5 ppm 0,01 ppm < 60 s F -20 °C ... 40 °C 5 ... 95 % 

Schwefeldioxid 
0 ... 100 ppm 

0 ... 100 200 0,5 ppm < ± 10 %  
 

0,1 ppm < 60 s D -20 °C ... 40 °C 5 ... 95 % 

VOC (4) 
0 ... 25 ppm 

0 ... 25 50 0,1 ppm < ± 10 %  
(0,1 ... 25 ppm) 

0,1 ppm < 60 s F -20 °C ... 40 °C 5 ... 95 % 

VOC (4) 0 ... 500 1000 1 ppm < ± 10 %  1 ppm < 60 s F -20 °C ... 40 °C 5 ... 95 % 

http://dict.leo.org/ende?lp=ende&p=CqhggsWkAA&search=Perchlorethylen&trestr=0x2001
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0 ... 500 ppm  

Temperatur -20 ... 
100 °C 

-40 ... 100 
°C 

0,01 °C < ± 3 °C 0,01 °C < 1 s - -40 ... 120 °C 0 ... 100 % 

Feuchtigkeit 0 ...  
100 % 

100 % 1 % r.F. 2 % r.F. 1 % r.F. < 1 s - -40 ... 120 °C 0 ... 100 % 

 
(1) Andere spezifische Konzentrationen auf Anfrage 
(2) Genauigkeit < 0,5 ppm nicht spezifiziert (für Messungen welche Genauigkeit unter < 0,5 ppm verlangen, benutzen Sie spezielle Sondenköpfe für 

Niederbereichsmessungen)  
(3) Kein Methan-Kohlenwasserstoff-Sensor (geringe Empfindlichkeit gegenüber Alkoholen und Ester) 
(4) Kalibriert in Abhängigkeit von Isobuten. Andere VOC-Kalibrierungen auf Anfrage 
(5) D = Diffusion, F = Lüfter 
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4 Gerätebeschreibung 
(Abbildung von AQ300 gilt schematisch auch für AQ500) 

 
 

(1) Sensorkopf 
(2) Power-Taste (Standby-Taste) 
(3) Display 
(4) Alarmtonstummschaltung (Mute) 
(5) Enter-Taste (Eingabetaste) 
(6) Scrollen (Hoch) 
(7) Scrollen (Runter) 
(8) Batteriefach 

 
 

 

(1) Power-Taste  
(2) Alarmtonstummschaltung (Mute) 
(3) Enter-Taste 
(4) Scrollen (Hoch) 
(5) Scrollen (Runter) 

 

 
 

5 Betriebsanleitung 

5.1 Einsetzen des Akkupacks 

 

 
1. Klappen Sie die Batteriefachabdeckung (5) vom Gerät weg 
2. Verbinden Sie den elektrischen Anschluss des Akkupacks mit dem des Messgeräts 
3. Legen Sie das restliche Verbindungskabel in die vorgesehene Aussparung und führen Sie den 

hinteren Teil des Akkupacks in die Gelenkpunkte des Batteriefachs ein 
4. Führen Sie den vorderen Teil des Akkupacks in die Halteclips ein (beachten Sie eventuelle 

Ausrichtungshinweise auf dem Akkupack) 
5. Setzen Sie die Batteriefachabdeckung wieder auf 

5.2 Laden des Akkupacks 

Da das Gerät über ein intelligentes Management zur Ladung verfügt, erfolgt der Ladeprozess nur 
wenn das Gerät eingeschaltet ist oder sich im Standby-Modus befindet. Während der Ladung blinkt 
das Batteriesymbol im Display in niedriger Frequenz. Das Akkupack kann mit oder ohne montierten 
Sensorkopf im Gerät geladen werden (achten Sie drauf vor Demontage des Kopfes das Gerät 
auszuschalten). Nach einer Höchstladezeit von 15 Stunden beendet das Gerät den Ladevorgang. 
Ziehen des Netzsteckers bewirkt einen Neubeginn der Ladezeit. Neue Ni-MH-Batterien müssen vor der 
ersten Nutzung vollständig geladen werden. Eine Ni-MH-Batterie entfaltet die volle Leistungsfähigkeit erst 
nach mehreren Zyklen von Ladung/Entladung. Ein vollgeladenes Akkupack hält für eine Dauer von ca. 
sieben Stunden (Perchloräthylen-Sensoren haben einen höheren Stromverbrauch und somit eine 
verkürzte Akkulaufzeit). Der Ladeprozess dauert im Standbymodus ca. 10, im Betriebsmodus ca. 15 
Stunden. 
 
Das intelligente Lademanagement der Version 5.1 beendet den Ladevorgang wenn eine der folgenden 
Bedingungen vorliegt: 

 Die volle Ladung von 10,5 V wurde erreicht 

 Es wurde für 15 Stunden geladen 

 Die Batterie kann keine weitere Ladung aufnehmen  
 

http://dict.leo.org/ende?lp=ende&p=CqhggsWkAA&search=Perchlor%C3%A4thylen&trestr=0x2001
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Wenn die Batterie nicht mehr über die volle Kapazität verfügt (ein Zeichen für Alterung der Batterie), wird 
im Batteriesymbol des Displays „RB“ angezeigt. Ein Austausch der Batterie empfiehlt sich. 

5.3 Warmlaufphase 

Vor der Nutzung benötigt das Gerät eine Aufwärmphase, um Verunreinigungen des Sensors zu 
verbrennen. Nach dem Einschalten wärmt das Gerät für drei Minuten auf. Danach blinkt die Anzeige für 
weitere sieben Minuten, um zu zeigen dass das Gerät noch immer in der Aufwärmphase ist. Es empfiehlt 
sich das Gerät bei Nichtnutzung im Standby-Modus zu belassen, um den Sensor warm zu halten und so 
Verunreinigung des selbigen zu verhindern. Wenn das Gerät mehr als sieben Tage ausgeschaltet war, 
sollte es vor einer Benutzung für 24 Stunden (über den Netzadapter) betrieben werden. 
 

Warnung: Nehmen Sie den Sensorkopf nicht ab während das Gerät eingeschaltet ist! Dies 
kann das Gerät beschädigen. Sollte dennoch eine Demontage des Sensors bei 
eingeschaltetem Gerät erfolgen, schaltet dieses sich automatisch ab.  

5.4 Externer Kontrollanschluss 

Die Pins für den externen Ausgangsanschluss sind von 1-6 nummeriert. Pin 1 ist jener, welcher sich am 
nähersten zum Anschluss des Netzadapters befindet.  
Die Pinbelegung lautet wie folgt: 

(1) 12 V DC 
(2) Analoger Ausgang 0-5 V 
(3) Steuerung 
(4) High-Alarm 
(5) Low-Alarm 
(6) Masse 

 
Der RJ12-Anschluss erlaubt zwei Arten der Verkabelung, entweder einen Schalter zu Masse, oder ein 12 
V-Ausgang. Wenn der 12 V-Ausgang genutzt wird, erfolgt die Versorgung der Relaisspule durch den 
geräteinternen AC/DC-Richter. In diesem Fall ist darauf zu achten, dass das Relais nicht mehr als 150 
mA zieht und eine Schutzdiode parallel zur Spule geschaltet ist. Wird der Schalter zu Masse benutzt, darf 
zusätzlich die Spannung 24 V nicht überschreiten. 

5.4.1 Alarmanschluss 

Hinweis: Diese Funktion kann nur benutzt werden wenn das Gerät mit dem Netzadapter betrieben wird. 
 
Die Pins für High- oder Low-Alarm können verwendet werden um einfache Ein-/Ausschalter zu 
versorgen, welche wiederum Geräte steuern die lediglich ein Ein-/Ausschaltsignal benötigen, z.B. 
Sirenen. Um zu Masse zu schalten, benutzen Sie die Pins (4), (5) und (6). Für den 12 V-Ausgang 
benötigen Sie die Pins (4), (5) und (1). Die Werkseinstellung basiert auf dem Sensorkopf welcher bei 
Gerätekauf ausgesucht wurde. 
 
Alarm bei hoher Gaskonzentration 

 
Warnung: Das Weglassen der erwähnten Diode kann einen Defekt des Gerätes zur Folge 
haben, wenn durch das Relais eine Spannungsspitze erzeugt wird.  
 

5.4.2 Steuerungsanschluss 

Hinweis: Diese Funktion kann nur benutzt werden wenn das Gerät mit dem Netzadapter betrieben wird. 
 
Der Pin der Steuerung (3) kann verwendet werden um, mittels Steuerung, eine Gaskonzentration 
zwischen oberer und unterer Grenze zu halten. Die obere und untere Grenze kann vom Benutzer 
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festgelegt werden. Die Werkseinstellung basiert auf dem Sensorkopf welcher bei Gerätekauf ausgesucht 
wurde. 
 
Um auf Masse zu schalten benutzen Sie die Pins (3) und (6). Für einen 12 V-Ausgang, schalten Sie die 
Pins (3) und (1). Steuerung wird durch Verwendung der Software erreicht. Wird dem Messgerät die 
Versorgungsspannung entzogen, öffnet sich der Schalter, wodurch das gesteuerte Gerät abgeschaltet 
wird (soweit einem „Schließer-Prinzip“ gefolgt wird).  
 
Steuerung der Gaskonzentration 

 
Warnung: Das Weglassen der erwähnten Diode kann einen Defekt des Gerätes zur Folge haben, wenn 
durch das Relais eine Spannungsspitze erzeugt wird.  
 

5.4.3 Anschluss des 0 ... 5 V-Analogausgangs (zwischen Pin (2) und Pin (6)) 

Das Ausgangssignal ist ein Signal welches in der Höhe proportional der Gaskonzentration entspricht. Die 
Spannungsaufteilung entspricht dem jeweiligen Messbereich des spezifischen Gases, z.B. entspricht 
beim Ozonsensor für niedrige Konzentrationen eine Spannung von 0 V einer Konzentration von 0 ppm, 
eine Spannung von 5 Volt einer Konzentration von 0,5 ppm Ozon. 

5.5 Ein- und Ausschalten des Geräts 

Um das Gerät einzuschalten, drücken und halten Sie die Power-Taste (2) bis ein Ton erklingt und das 
Display aktiviert wird. Im Display wird die Version des Geräts und der Software angezeigt. Nach fünf 
Sekunden wird der Sensortyp angezeigt und die Aufwärmphase (wie oben beschrieben) beginnt. Nach 
Abschluss der Aufwärmphase erfolgt die Hauptanzeige, wie hier exemplarisch erkennbar: 

      

 
Um das Gerät auszuschalten, drücken und halten Sie die Power-Taste (2) für ca. zwei Sekunden. Ein 
Ton erklingt und die Displayanzeige verschwindet. 

5.6 Ein- und Ausschalten des Standby-Modus 

Um bei eingeschaltem Gerät in den Standby-Modus zu gelangen, drücken Sie (einmalig und kurz) die 
Power-Taste (2). Dies beendet die Messfunktion; der Sensor wird jedoch warmgehalten. Dieser Modus 
ermöglicht es Energie zu sparen, und dennoch nur eine kurze Aufwärmphase bei Wiederaufnahme der 
Messtätigkeit hinnehmen zu müssen. Die Displayanzeige sieht bei Standby wie folgt aus: 

 Um in den Messmodus zurückzukehren, drücken Sie erneut (einmalig und kurz) die Power-Taste. 
 
Hinweis: Bei Verwendung eines Kohlendioxid-Sensors wird dieser im Standby-Modus mit voller Leistung 
betrieben. Auch der Lüfter bleibt eingeschaltet. 
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5.7 Batteriebetrieb 

Bei Arbeiten im reinen Batteriebetrieb wird im unteren Displaybereich ein Batteriesymbol angezeigt. Das 
Symbol verändert sich mit dem Ladestand der Batterie. 

5.8 Ausfall des Sensorkopfs 

Es gibt zwei Anzeigen welche auf ein Problem mit dem Sensorkopf hinweisen: 
 
„Sensor Failure, Replace sensor“: Der Sensorkopf sollte getauscht werden, da ein Komponentenfehler 
vorliegt oder der Sensor das Ende seiner Lebensdauer erreicht hat. 
 
„Sensor aging“: Der Sensorkopf sollte schnellstmöglich getauscht werden, da er das Ende seiner 
Lebensdauer erreicht hat. Die Messergebnisse sind nicht länger verlässlich.  

5.9 Nutzung der Menüs und Funktionstasten 

Um in das Menü zu gelangen, drücken Sie die Eingabetaste (5). Eine der beiden folgenden Anzeigen 
erscheint (links das normale Menü, recht bei aufgestecktem Perchloräthylen-Sensor): 

 
Benutzen Sie die Scroll-Tasten (6), (7) um zum gewünschten Menüpunkt zu scrollen.  

5.9.1 Nullkalibrierung (ZERO CAL) 

Die Nullkalibrierung legt den Nullpunkt für die Messung fest. Die Kalibrierung muss unter strengen 
Bedingungen erfolgen, wie da wären:  

 Mindestens 24 Stunden Warmlaufphase 

 Saubere Luft  (Aktivkohle-gefilterte Luft ist am besten geeignet), keine querempfindlichen Gase  

 Stabiler und geringer Luftzug um das Gerät 

 Keine Vibration oder Bewegung des Messgeräts 

 Temperatur 20 °C ± 2 °C 

 Relative Luftfeuchtigkeit 50 % ± 5 % 
 
Eine fehlerhafte Nullkalibrierung führt nicht zu einem dauerhaften Schaden am Gerät. Die Kalibrierung 
sollte allerdings unter o.g. Bedingungen wiederholt werden. 
 

Warnung: Die Nullkalibrierung von Kohlendioxidsonden muss zwingend in einer qualifizierten, 
umgebungsluftfreien Atmosphäre erfolgen. Im Zweifelsfall kontaktieren Sie uns bitte. 
 

 
Drücken und halten Sie die Enter-Taste bis der Schriftzug „GO“ erscheint. Der Kalibrierungsprozess 
nimmt ca. 3-10 Minuten in Anspruch. Nach Abschluss ertönt ein Signal. 
Drücken Sie die Scroll-Taste (Runter) um zum nächsten Menüpunkt zu gelangen. 

5.9.2 Einstellen der Uhr (nur AQ500/505) 

Um in das Menü zu gelangen, drücken Sie die Eingabetaste (5). Die folgende Anzeige erfolgt: 

 
Um die Stunden zu ändern benutzen Sie die Scroll-Tasten. Bestätigen Sie Ihre Einstellungen mit der 
Eingabetaste. Bedenken Sie bitte dass es sich um eine 24-Stunden-Uhr handelt. Nach der Bestätigung 
rückt der Cursor automatisch zur nächsten Stelle vor. Die Einstellung der anderen Zeitparameter 

http://dict.leo.org/ende?lp=ende&p=CqhggsWkAA&search=Perchlor%C3%A4thylen&trestr=0x2001


 BETRIEBSANLEITUNG  
                                      www.warensortiment.de 

 

12 

funktioniert nach demselben Schema. Um zum nächsten Menüpunkt zu gelangen, betätigen Sie die 
Scroll-Taste (Runter).  

5.9.3 Einstellung des High- und Low-Alarms 

Um in das Menü zu gelangen, drücken Sie die Eingabetaste (5). 
 
Einstellen des High-Alarms 
Nach dem Aufrufen des Alarm-Setup-Menüs wird „Alarm HI“ angezeigt. 

 
Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der Eingabetaste. 
 
Einstellen des Low-Alarms 
Nach Bestätigung der Einstellung des High-Alarms wechselt die Ansicht automatisch in die Einstellung 
des Low-Alarms. Im Display wird „Alarm LO“ angezeigt. 

 
Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der Eingabetaste. 
 
Hinweis: Diese Einstellung gilt für den Gerätealarm und den externen Alarm. 

 
Ein- und Ausschalten des Alarms 
Nach Bestätigung der Einstellung des Low-Alarms wechselt die Ansicht automatisch in die „Buzzer“ 
Einstellung. 

 
Benutzen Sie die Pfeiltasten um zwischen „ENABLE“ (Aktiviert) und „DISABLE“ (Deaktiviert) zu wählen. 
Bestätigen Sie die Einstellung mit der Eingabetaste. 
 
Hinweis: Wenn der Alarm deaktiviert wurde, gilt diese Stummschaltung permanent. Ein „P“ im Display 
(rechts neben dem Stummschaltungssymbol) symbolisiert dies. 
 
Displayanzeige bei High-Alarm 

 
Zwei nach oben weisende, blinkende Pfeile erscheinen im Display wenn die Ozonkonzentration über 8.00 
ppm steigt. Akustisch wird der Alarm durch ein schnelles Piepen begleitet. 
 
Displayanzeige bei Low-Alarm 

 
Zwei nach unten weisende, blinkende Pfeile erscheinen im Display wenn die Ozonkonzentration über 
0,015 ppm steigt. Akustisch wird der Alarm durch ein langsames Piepen begleitet. 
 
Displayanzeige bei Alarm-Mute (Alarmstummschaltung) 

 
Diese Funktion wird durch Betätigung der Mute-Taste (4) aktiviert und durch einen durchgestrichenen 
Lautsprecher im Display symbolisiert. Stummschalten eines aktiven High- oder Low-Alarms gilt nur so 
lange die aktuelle Alarmbedingung vorliegt. Bewegt sich die Ozonkonzentration wieder in die 
Schrankenwerte, wird die Stummschaltung deaktiviert.   
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Displayanzeige bei permanentem Alarm-Mute (permanenter Alarmstummschaltung) 

 
Das Symbol (durchgestrichener Lautsprecher und „P“) wird permanent angezeigt, bis die 
Stummschaltung im Menü aufgehoben wird. Sollte eine Alarmgrenze überschritten sein, werden die 
blinkenden Pfeile angezeigt. Ein akustisches Warnsignal ertönt nicht. 
Drücken Sie die Scroll-Taste (Runter) um zum nächsten Menüpunkt zu gelangen. 

5.9.4 Einstellen der Steuerpunkte (Control points) 

Um in das Menü zu gelangen, drücken Sie die Eingabetaste (5). 
 
Einstellen des High-Steuerpunktes 
Nachdem das Control-Menü aufgerufen wurde, erfolgt die Anzeige „CONTROL HI“. 

 
Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der Eingabetaste. 
 
Einstellen des LO-Steuerpunktes 
Nach Bestätigung der Einstellung des High-Steuerpunktes wechselt die Ansicht automatisch in die 
Einstellung des Low-Steuerpunktes. Im Display wird „CONTROL LO“ angezeigt. 

 
Benutzen Sie die Pfeiltasten um den Wert zu ändern. Bestätigen Sie die Einstellung mit der Eingabetaste. 
Drücken Sie die Scroll-Taste (Runter) um zum nächsten Menüpunkt zu gelangen. 
 
Hinweis: Nachdem die Steuerpunkte eingestellt wurden, muss das Gerät entweder in den Standby-
Modus versetzt oder ausgeschaltet werden um die neuen Einstellungen zu aktivieren.  

5.9.5 Einstellen der Zeitintervalle des Datenloggers (nur AQ500/505)  

Um in das Logging-Menü zu gelangen, drücken Sie die Eingabetaste (5). Die Anzeige „LOG FREQ“ 
erscheint.  

 
Benutzen Sie die Pfeiltasten um den Loggingwert in 1-Minuten-Schritten zu ändern. Bestätigen Sie die 
Einstellung mit der Eingabetaste und die folgende Anzeige erscheint:  

 
Sie können nun wählen ob sie die geloggten Daten löschen oder behalten möchten, indem Sie, mittels 
der Pfeiltasten, zwischen „YES“ und „NO“ wählen. Hierbei bedeutet „YES“ dass die Daten gelöscht 
werden sollen. Bestätigen Sie die Einstellung mit der Eingabetaste und die folgende Anzeige erscheint:  

 
Benutzen Sie die Pfeiltasten um zwischen  „ON“ und „OFF“ zu wählen. Bestätigen Sie die Einstellung mit 
der Eingabetaste und das Hauptmenü erscheint. 
Drücken Sie die Scroll-Taste (Runter) um zum nächsten Menüpunkt zu gelangen. 

5.9.6 Ändern der Messeinheit (UNIT) 

Drücken Sie die Enter-Taste um in das Menü „UNITS“ zu gelangen. Einmaliges Drücken führt in die 
Einstellung der Einheit für Konzentration, zweimaliges Drücken in die Einstellung der Einheit für 
Temperatur (nur bei AQ305/505). 
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Benutzen Sie die Pfeiltasten um zwischen „ppm“ und „mg/m³“, bzw. „°C“ und „°F“ zu wählen. Bestätigen 
Sie die Einstellung mit der Eingabetaste.  
Drücken Sie die Scroll-Taste (Runter) um zum nächsten Menüpunkt zu gelangen. 

5.9.7 Max/Min/Durchschnitt des Messungsdurchlaufs 

Betätigung der Enter-Taste startet/stoppt die Max/Min/Durchschnitt-Prozedur. Drücken Sie die Scroll-
Taste (Runter) um zum Punkt „EXIT“ zu scrollen. Drücken Sie die Enter-Taste um die Menüeinstellungen 
zu verlassen. Hierdurch wird auch, je nach Menüauswahl, der Durchlauf gestartet.  
 
Hinweis: Es gibt auch eine Tastenfunktion, welche ein schnelles starten/stoppen des Durchlaufs 
ermöglicht. Drücken und halten Sie hierzu im Hauptbildschirm die Scroll-Taste (Runter) für mindestens 
zwei Sekunden, bis der akustische Signalgeber ertönt. Hierdurch wird der Durchlauf gestartet und die 
folgende Anzeige erscheint (die rechte Darstellung bezieht sich auf AQ305/305): 

Um die Messung zu stoppen, drücken die erneut die Scroll-Taste (Runter) für mindestens zwei 
Sekunden, bis der akustische Signalgeber ertönt. 
 
Hinweis: Die MIN, MAX und AVE-Werte sind Minimal-, Maximal- und Durchschnittswerte seit Beginn des 
Messungsdurchlaufs. Der Wert „ST“ ist der Durchschnittswert über die letzen 15 Minuten. 

5.10 Starten und Stoppen des Datenloggings (nur AQ500/505) 

Drücken und halten Sie hierzu im Hauptbildschirm die Scroll-Taste (Runter) für mindestens zwei 
Sekunden, bis der akustische Signalgeber ertönt. Hierdurch wird die Aufzeichnung gestartet. Im unteren 
Bereich des Displays erscheint ein Dreieck. 

Um die Aufzeichnung zu stoppen, drücken die erneut die Scroll-Taste (Runter) für mindestens zwei 
Sekunden, bis der akustische Signalgeber ertönt. 
 
Hinweis: Das Dreieck-Symbol zeigt dass die Datenlogging-Funktion aktiv ist, aber dient auch der 
Statusanzeige für den Speicher: 

 Ein leeres Dreieck signalisiert dass keine Daten gespeichert sind 

 Ein halbvolles Dreieck signalisiert dass einige Daten gespeichert sind 

 Ein volles Dreieck signalisiert dass de Speicher voll ist und sein Inhalt auf den PC überspielt 
werden sollte. 

5.11 Löschen des Datenspeichers 

Um den Datenspeicher zu löschen, muss das Logging zuvor beendet werden. Der Speicher kann dann 
durch Drücken und Halten der Mute-Taste (4) für über zwei Sekunden gelöscht werden. Die Löschung 
wird durch ein akustisches Signal bestätigt. Alternativ kann im Menü „LOGGING SETUP“ die Funktion 
„CLEAR LOG“ genutzt werden. 
 

6 Anleitung für die Software 
Die Software der Geräte AQ500 und AQ505 für Microsoft Windows

TM
 enthalten Java

TM
1.5.0 runtime 

virtual machine, eine Java-Datenbank und alle nötigen Komponenten um die Software in Verbindung mit 
dem Gerät zu betreiben.  
Hinweis: Das AQ505 speichert sowohl Gaskonzentration, relative Feuchte, wie auch Temperatur. 
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6.1 Softwareinstallation 

Softwarelizenz 
Die Geräte AQ500 und AQ505 werden zusammen mit der Software ausgeliefert. Der Hersteller behält 
das geistige Eigentum. Der Käufer erkennt an, dass ihm eine unbefristete, nicht-exklusive, nicht 
übertragbare Lizenz zur eigenen Nutzung der Software nur in Zusammenhang mit dem Messgerät erteilt 
wird. Der Käufer wird sich strikt an diese bestimmungsgenmäße Nutzung halten und die Software nicht 
übersetzen, umarbeiten, dekompilieren, deassemblieren oder in sonstiger Weise abändern. Der Käufer 
akzeptiert die Software nicht zu verkaufen, vermieten, übergeben, veröffentlichen, verleihen, Sublizenzen 
zu vergeben oder die die anderweitig weiterzugeben.  
 
Softwarefeatures 

 Echtzeit-Überwachung der Gaskonzentration und Aufzeichnung von Daten 

 Ereigniserfassung. Wenn die Gaskonzentration eine, durch den Anwender definierte, Grenze 
überschreitet, wird dieses Ereignis erfasst und in der Datenbank hinterlegt 

 Datenanalyse der gespeicherten Werte mittels graphischer Darstellung. Die Darstellung kann 
durch den Anwender konfiguriert werden 

 Das durchschnittliche Level der Gaskonzentration kann sowohl in der Echtzeitanzeige als auch in 
der Darstellung der Speicherwerte erfolgen 

 Graphische Darstellungen können als JPG-Datei gespeichert werden 

 Geloggte Daten können in anderen Formaten (z.B. zur Verwendung mit Microsoft Excel
TM

) 
exportiert werden. 

 Konfiguration der Geräteeinstellungen vom PC aus 

 Sicherung und Widerherstellung von geloggten Daten 

 Dem Sensor kann ein Name oder eine ID zugeteilt werden. Der Name kann geändert werden 

 Der Umrechnungsfaktor für die Einheiten (ppm oder mg/m³, bzw. °C oder °F) kann verändert 
werden 

 Daten verschiedener Sensoren können in derselben Datenbank gespeichert werden, müssen 
jedoch separat heruntergeladen werden 

 Die Geräteversionen V5.0 und höher sind nicht mit früheren Softwareversionen kompatibel  
 
Systemanforderungen 
Betriebssystem: Microsoft Windows

TM
 2000, XP, Vista 

Prozessor: 600 MHz oder schneller. 
Arbeitsspeicher (RAM): 256 MB (Minimum) 
Verfügbarer Festplattenspeicher: 90 MB (Minimum) 
Schnittstelle: Seriell (oder mittels USB-Seriell-Adapter) 
 
Installationsvorgang 

 Legen Sie die CD-ROM in das CD-ROM-Laufwerk des Computers ein 

 Öffnen Sie die Datei „S500-x-x.exe“ und folgen Sie den Anweisungen des 
Installationsprogramms 
(Bei Windows Vista, entpacken Sie die Vista-Software, welche sich daraufhin selbstständig 
installieren sollte) 

6.2 Benutzung der Software 

 Verbinden Sie das Messgerät mittels des beiliegenden Kabels mit dem COM-Anschluss Ihres 
Computers 

 Schalten Sie das Gerät ein  

 Starten Sie das Programm S500. Die folgende Anzeige erfolgt: 
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Einstellen der Software- und Geräteparameter 
Dieses Kapitel der Anleitung befasst sich mit dem Vorgehen um mittels der Software Alarme, externe 
Steuergrenzen, Loggingzeiten, Einheiten und Sensorverhalten festzulegen.  
Wählen Sie „Monitor -> Setup“ oder drücken Sie „Strg+P“.Die folgende Anzeige erfolgt: 

 
Geben Sie die gewünschten Werte ein. Klicken Sie den Button „Upload“ um die 
Einstellungen der Software mit dem Gerät zu synchronisieren. Wenn der Upload 
beendet ist piept das Gerät. Klicken Sie den Button „Ok“ um die Einstellungen 
der Software zu bestätigen.  
Um sinnvolles Datenlogging zu betreiben ist es notwendig die Uhrzeit des 
Geräts korrekt einzustellen. Dies kann direkt über die Tastatur des Geräts oder 
über den Button „Update Clock“ der Software erfolgen.  
 
Hinweise: Wenn Sie ein AQ505 benutzen, vergewissern Sie sich dass das 
Kontrollfeld „S505 base with Temp/RH sensor“ aktiviert ist. Dies konfiguriert die 
Software auf S505 und zeigt ein Feld welches mit „Temperature Unit“ benannt 
ist. Die Geräteeinstellungen können mittels des Buttons „Download“ auf den PC 
aufgespielt werden. 

 
Konfiguration der Gassensoreigenschaften  
Wählen Sie „Monitor -> Setup“ oder drücken Sie „Strg+P“. Wählen Sie die Registerkarte „Gas Sensor“. 

 
Im Feld „Sensor Name“ kann ein beliebiger Name für den Sensor mit bis zu 
sieben Zeichen festgelegt werden. Der Umrechenfaktor von ppm auf mg/m³ 
ist änderbar um an unterschiedliche Sensoren angepasst zu werden. Durch 
Klicken des Buttons „Update“ werden die momentanen Einstellungen im 
Sensorkopf gespeichert. Mittels des Buttons „View“ kann die momentan im 
Sensorkopf gespeicherte Einstellung betrachtet werden. 
  
 
 
 
 
 

 
Konfiguration der Schnittstelle 

Hinweis: Wenn Sie nicht über eine serielle Schnittstelle verfügen, ist ein 
entsprechender USB-Adapter erforderlich. 
Rufen Sie die Schnittstelle auf in welche das Kabel des Messgerätes eingesteckt 
wurde. Wenn es sich nicht um COM1 (Voreinstellung) handelt, muss die 
Konfiguration auf COM2 oder einen anderen Port vorgenommen werden. 
Wählen Sie „Monitor -> Com Port“ oder drücken Sie „Strg+M“. Die links 
abgebildete Anzeige erfolgt. Wählen Sie den entsprechenden Anschluss aus. 
Die anderen Werte sollten nicht verändert werden. Bestätigen Sie Ihre Auswahl 
mit dem Button „Ok“. 
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Konfiguration der graphischen Darstellung 
Im Dialogfeld „Graph Styles“ können die Eigenschaften der Graphen 
gespeicherter Daten und Echtzeitbeobachtungen festgelegt werden. Das 
Dialogfeld umfasst die Punkte:  

 Achsabschnitte der oberen und unteren Gasskalen 

 Skalenteilung und Zeiteinheiten  

 Farben des Graphen und des Hintergrundes 

 Farben Alarm- und Steuerpunktlinien 

 Typ des Graphen (Linie oder Punkte) 

 Durchschnittslinie ein- oder ausblenden 
 
Um in die Einstellungen zu gelangen: 
Wählen Sie „Data -> Graph -> Default Style“. Bestätigen Sie Ihre Auswahl 
mit dem Button „Ok“. 

 
Einstellen der Loggingeigenschaften 
 
Datenlogging bei AQ500 und AQ505 
Ein Messgerät des Typs AQ500 kann bis zu 4300 Datenpunkte (3400 bei AQ505) in seinem internen 
Speicher ablegen. 
 
Ansehen der Sensoreigenschaften 
Diese Funktion wird benutzt um Sensorinformationen der Datenbank zu aktualisieren und Verbindungen 
zu testen. Klicken Sie „Monitor -> View Sensor Properties“. Das Messgerät muss eingeschaltet und mit 
dem PC verbunden sein. Um die Sensordaten der Datenbank zu aktualisieren, klicken Sie den Button 
„Save“, nachdem Sie die erforderlichen Änderungen vorgenommen haben. Um Daten mit demselben 
Messgerät, aber unterschiedlichen Sensoren aufzuzeichnen, müssen bei jedem Sensorwechsel auch die 
Eigenschaften in der Software angepasst werden. Wenn die Informationen nicht in der Datenbank 
gespeichert sind klicken Sie „Monitor -> Show Sensor Properties“, passen Sie die Einstellungen an und 
klicken Sie den Button „ Save“.  
 
Um geloggte Daten vom Gerätespeicher auf den PC zu überspielen, klicken Sie „File -> Download 
Logged Data“ oder drücken Sie „Strg+D“ oder betätigen Sie das Shortcut-Symbol . 
 
Während die Daten heruntergeladen werden, wird ein Fortschrittsbalken angezeigt. Nach Abschluss des 
Download-Vorgangs piept das Messgerät. Die Software fragt ob die Daten im Speicher des Messegeräts 
nun gelöscht werden sollen. Daten können nur manuell gelöscht werden. Eine automatische Löschung, 
z.B. nach bestimmter Zeit, erfolgt nicht.  
Wenn der Datendownload nicht abgeschlossen, abgebrochen oder unterbrochen wird: 

 Schalten Sie das Messgerät aus um Datenverlust zu vermeiden 

 Löschen Sie die Daten welche bereits auf den PC übertragen wurden 

 Schließen Sie die Software 

 Wiederholen Sie den Download-Vorgang (vergessen Sie nicht dass das Gerät eingeschaltet sein 
muss) 

 
Direktes Datenlogging auf einen PC 

Klicken Sie „File -> Start PC Data Logging“ oder das Symbol . 
Die Daten werden nun direkt in der Datenbank auf dem PC gespeichert. In diesem Modus werden keine 
Daten im geräteinternen Speicher abgelegt. Wenn der Vorgang des direkten Datenloggings jedoch 

beendet wird (durch Klick auf den Button „Stop“ ), werden die ab diesem Moment folgenden 
Messdaten wieder im geräteinternen Speicher aufgezeichnet. Während direkt auf den PC geloggt wird, 
wird ein Echtzeit-Graph/Tabelle gezeigt: 
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Hinweise: Temperatur- und Feuchtigkeitsgraphen werden nur angezeigt wenn das Kontrollfeld für „S505“ 
der Software aktiviert wurde. Neue eingehende Daten werden an unterster Stelle in der Tabelle 
hinzugefügt. Die maximale Zeilenzahl der Tabellenansicht beträgt 50.   
 
Graphik- und Datenanalysefunktionen  
Um sich geloggte Daten als Graphen anzusehen: 

 Stellen Sie sicher dass alle Daten vom Messgerät auf      
 den PC   übertragen wurden 

 Klicken Sie „Data -> Graph -> Logged Data“ ,  
oder Strg+G 

  Wählen Sie den Zeitraum dessen Daten im Graphen 
dargestellt werden sollen 

 Wählen Sie die gewünschte Zeiteinteilung und den                                                                                                    
Sensor 

 Klicken Sie den Button „Apply“ um den Graphen    
aufzurufen 

 
Hinweis: Die Angabe „Quarters“ im Auswahlmenü der 
Zeiteinteilung steht für einen Intervall von 15 Minuten. 

 
Drucken einer graphischen Ansicht 
Zum Drucken einer graphischen Ansicht drücken Sie den Button „Print“. Ein Fenster in welchem ein Titel 
eingegeben werden kann erscheint. Geben Sie einen Titel ein um die Messung eindeutig zuordnen zu 
können. Zum Bestätigen klicken Sie den Button „OK“ und folgen den weiteren Anweisungen zum Druck. 
 
Einen Graphen als Bild abspeichern 
Klicken Sie den Button „Save“ und vergeben Sie einen Namen. Der Graph wird als JPG-Datei 
abgespeichert.  
 
Darstellung der Graphik ändern 
Klicken Sie den Button „Style“. Ein Dialogfenster erscheint. Nehmen Sie die gewünschten Änderungen 
vor und bestätigen Sie mit dem Button „OK“. 
 
Vergrößern eines Bereichs des Graphen 
Zur Vergrößerung markieren Sie den gewünschten Bereich mit der Maus. Beim Loslassen der Maustaste 
wird der entsprechende Bereich vergrößert dargestellt. 
 
Darstellung aus Grundeinstellung zurücksetzen 
Um zur Grundeinstellung der Darstellung zurückzukehren, betätigen Sie den Button „Reset“.  
 
Geloggte Daten in einer Tabelle anzeigen 
Um geloggte Daten in einer Tabelle darzustellen, klicken Sie „Data -> Table -> Logged Data“, oder 
Strg+E. Die Tabelle wird angezeigt. Wählen Sie den gewünschten Zeitraum und den Sensor. Klicken Sie 
den Button „Apply“ um die Auswahl zu bestätigen und die Daten zu laden. Die Tabelle kann durch Klicken 
auf die jeweilige Kolumne sortiert werden (z.B. um nach Konzentration zu sortieren). 
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Wenn Daten nicht länger benötigt werden, können sie mittels des 
Buttons „Delete“ entfernt werden.  
 
Zum Drucken einer Tabelle drücken Sie den Button „Print“. Ein 
Fenster, in welchem ein Titel eingegeben werden kann, erscheint. 
Geben Sie einen Titel ein um die Messung eindeutig zuordnen zu 
können. Zum Bestätigen klicken Sie den Button „OK“ und folgen 
den weiteren Anweisungen zum Druck. 
 
Um Daten zu exportieren, klicken Sie „File -> Export Logged Data“. 
Um die Tabellendaten zur Weiterverarbeitung zu speichern, klicken 
Sie im Dialogfenster der Tabellenansicht den Button „Export“. 
Geben Sie ein Zielverzeichnis sowie einen Dateinamen ein und 

wählen Sie ein Dateiformat (Klarformat oder MS EXCEL
TM

-Format). Klicken Sie den Button „Save“ um die 
Daten zu exportieren. 
 
Analyse der Tageszusammenfassung   

Die Tageszusammenfassung ist ein Bericht für jeden Tag, 
von Mitternacht bis Mitternacht, welcher die minimale, 
maximale und durchschnittliche Gaskonzentration der letzten 
24 Stunden angibt. 
 
Erstellen und Betrachten der Tageszusammenfassung 
Zur Erstellung und Betrachtung klicken Sie „Data -> Analysis 
-> Daily Analysis“. Wählen Sie den Datenbereich und den 
Sensor. Klicken Sie den Button „Apply“ um die Analyse zu 
erstellen. 
 
Hinweis: Der Erstellungsprozess kann zehn Minuten oder 
länger benötigen und darf nicht unterbrochen werden. Die 
Prozessdauer ist von der Menge der zu verarbeitenden 
Daten abhängig. 

 
Mittels des Buttons „Export“ kann die Zusammenfassung als Datei (z.B. für MS EXCEL

TM
) exportiert 

werden. Auch kann der Button „Delete“ zur Löschung der Zusammenfassung genutzt werden. Hierbei 
wird nur die Zusammenfassung gelöscht, nicht die zugrundeliegenden Daten. 
 
Ansehen geloggter Ereignisse (Events) 
Ein Ereignis liegt vor wenn die Gaskonzentration eine vorgegebene Grenze überschreitet. In diesem Fall 
erscheint eine Warnmeldung. Diese Warnmeldung dient auch als Dialogfenster. In einem Textfeld kann 
festgehalten werden, wie und durch wen ein Problem gelöst wurde. Klicken des Buttons „OK“ bewirkt 
dass die Meldung in der Datenbank gespeichert wird.  
 
Um diese festgehaltenen Ereignisse anzusehen, klicken Sie „Data -> Table -> Logged Events“, oder 
drücken Sie Strg+L. Ein Ansichtsfenster erscheint. Auch hier ist wieder ein Datenexport über den Button 
„Export“ möglich. Das Löschen von Daten erfolgt über den Button „Delete“. 
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Fortgeschrittenes Datenmanagement 
Gepackte Datei (Zip-database) aus der Datenbank erzeugen 
Um aus der Datenbank eine gepackte Datei zu erzeugen, klicken Sie „File -> Zip Database“. Wählen Sie 
ein Zielverzeichnis und geben Sie einen Namen ein um eine Datei aus allen gespeicherten Daten zu 
erstellen.  
 
Ansehen der erstellten Datei 

Warnung: Soll eine gesicherte Datenbank angesehen werden, ist es von großer Wichtigkeit 
dass eine aktive Loggingfunktion nicht unterbrochen wird. Empfohlen wird, eine gesicherte 
Datenbank nicht auf dem PC anzusehen auf welchem ein Loggingvorgang durchgeführt wird, 

da, wenn Daten wiederhergestellt werden, die aktuellen Daten verloren gehen, soweit diese nicht 
gesichert wurden. 
 
Ansehen der erstellten Datei an einem anderen PC 

 Installieren Sie die Software auf dem gewünschten PC 

 Kopieren Sie die Zip-Datei auf den PC 

 Klicken Sie „File -> unzip Database“  

 Wählen Sie die gezippte Datei und klicken Sie den Button „OK“ 

 Betrachten und analysieren Sie die Daten 
 
Ansehen der erstellten Datei an demselben PC 

1. Stoppen Sie das PC-Datenlogging (weitere Daten werden im Messgerät geloggt) 
2. Erstellen Sie aus der vorliegenden Datenbank eine Zip-Datei. 
3. Entpacken Sie die zu betrachtende Datenbank (“File -> Unzip Database“) 
4. Betrachten und analysieren Sie die zu betrachtende Datenbank („Data -> Table -> Logged“) 
5. Zippen Sie die Datenbank nach dem Betrachten wieder 
6. Entpacken Sie die Datenbank aus 2. 
7. Laden Sie die Daten vom Messegerät auf den PC herunter, welche im Speicher des Messgeräts 

festgehalten wurden während Sie die andere Datenbank betrachtet haben 
8. Starten Sie das PC-Datenlogging (dies gewährleistet eine Fortsetzung der Aufzeichnung ohne 

Datenverlust) 
 
 

7 Wartung und Reinigung 

7.1 Fehlersuche 

Fehlerbeschreibung Mögliche Fehlerursache Abhilfe 

Gerät lässt sich nicht 
einschalten 

Netzgerät defekt 
 
 
Batterie leer 
 
Messgerät defekt 
 
Sensorkopf defekt 

Überprüfen Sie die Leitungen 
/Tauschen Sie das Netzgerät 
 
Laden/Wechseln Sie die Batterie 
 
Tauschen Sie das Messgerät 
 
Tauschen Sie den Sensorkopf 

Externer Alarm und 
Steuerung funktionieren 
nicht korrekt 

Falsche RJ12-Pins verwendet 
 
Keine Diode parallel zur externen 
Relaisspule  
 
Polarität der Diode falsch 

Überprüfen Sie die Verkabelung 
 
Setzen Sie eine Diode ein 
 
 
Korrigieren Sie die Polarität 

Sensorfehler trotz neuem 
Sensorkopf 

Unzureichende Warmlaufphase 
 
Unreine Umgebungsluft 
 
Sensor beschädigt 

Betreiben Sie den Sensor bei 
eingeschaltetem Gerät für 24-48 h 
Bringen Sie das Gerät in eine 
andere Umgebung 
Tauschen Sie den Sensorkopf 
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Hohes Messergebnis trotz 
(relativ) gasfreiem Raum 

Umgebungsluft außergewöhnlich 
belastet 
 
Sensor beschädigt 

Bringen Sie das Gerät in die 
vorgebene Umgebung und führen 
Sie eine Nulljustierung durch 
Tauschen Sie den Sensorkopf 

Messergebnis in 
gashaltiger Umgebung 
höher als erwartet 

Ergebnis korrekt 
Sensoreinsatz kontaminiert 
 
Sensorlüfter defekt 
 
Querempfindliches Gas 
vorhanden 
 
 
Gas reaktiv und bildet Verbindung 
vor Erfassung 
 
Gasfluss zu hoch (Ozonmessung) 
oder zu gering (Ammoniak- und 
VOC-Messung) 
 
Sensor hat Kalibrierung verloren 

Gasgenerator defekt 
Netz und Filter des Sensors 
reinigen 
Tauschen Sie den Sensorkopf 
 
Bringen Sie das Gerät in eine 
andere Umgebung und 
überprüfen Sie es mittels einer 
bekannten Gaskonzentration 
Bringen Sie den Sensor näher an 
die Gasquelle 
 
Sorgen Sie für angemessenen 
Fluss in und um den Sensor 
 
 
Überholen/Tauschen Sie den 
Sensorkopf 

Messergebnis in 
gashaltiger Umgebung 
niedriger als erwartet 
 
 
 

 

Ergebnis korrekt 
 
Querempfindliches Gas 
vorhanden 
 
 
 
Sensor hat Kalibrierung verloren 

Gasgenerator defekt 
 
Bringen Sie das Gerät in eine 
andere Umgebung und 
überprüfen Sie es mittels einer 
bekannten Gaskonzentration 
 
Überholen/Tauschen Sie den 
Sensorkopf 

Messergebnis instabil Spannungsversorgung instabil 
 
Nennstrom falsch 
 
Luftzug zu groß 
 
Umgebungsbedingungen ändern 
sich schnell 
 
Rauschen über das Datenkabel 
zwischen Messgerät und PC 
aufgenommen (AQ505/AQ505) 

Sorgen Sie für stabile Spannung 
 
Sorgen Sie für korrekte 
Stromversorgung 
Reduzieren Sie den Luftstrom 
 
Reduzieren Sie die 
Umgebungseinflüsse 
 
Stecken Sie das Kabel aus um zu 
sehen ob dies die Messung 
stabilisiert. In diesem Fall 
verwenden Sie ein anderes Kabel 
oder schirmen Sie den PC ab. 

Datenverbindung instabil 
(nur bei AQ500/AQ505) 

Leitung unterbrochen 
 
Einstellung des COM-Ports falsch 
 
Uhreinstellung falsch 

Prüfen Sie das Kabel und die 
Anschlüsse 
Nehmen Sie die korrekten 
Einstellungen vor 
Synchronisieren Sie die Uhr des 
Messgerätes mit der Uhr des PC 
(mittels der Software). Wenn dies 
nicht möglich ist, kann die 
geräteinterne Batterie defekt sein. 
Wenden Sie sich an PCE. 
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7.1.1 Sensorausfall 

Die Geräte verfügen über integrierte Diagnosefunktionen um Sensordefekte zu erkennen. Falls ein 
Sensorkopf ausfällt, kann er durch wenige Handgriffe ausgetauscht werden. Ein ausgefallener Sensor 
kann zu PCE zurückgesandt werden, um aufbereitet oder entsorgt zu werden. 
 

Fehler-
beschreibung 

Display-
anzeige 

0-5 Volt-
Ausgang 

Steuer-
ausgang 

Low-Alarm-
Ausgang 

High-Alarm-
Ausgang 

Daten-
logging 
(AQ500/ 
AQ505) 

Kein Fehler Gültiger 
Messwert 

Wert 
proportional 
zum 
Messergebnis 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Gültiger 
Messwert 

Sensor  
defekt 

„Sensor 
failure“ 

5 V Offen Geschlossen Geschlossen 9999 

Sensor  
überaltert 

Gültiger 
Messwert 
+ „Sensor 
aging“ 

Wert 
proportional 
zum 
Messergebnis 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Wie vom 
Benutzer 
eingestellt 

Gültiger 
Messwert 

Verbindungs-
fehler 

Gerät 
schaltet 
sich ab 

0 V Offen Offen Offen Keine 
Ausgabe 

Sensor  
Standby 

Standby-
Symbol 

0 V Offen Offen Offen Keine 
Ausgabe 

7.2 Reinigung 

Das Gerät sollte nur mit einem feuchten Tuch gereinigt werden. Keine Scheuermittel oder 
lösemittelhaltige Reinigungsmittel verwenden. 
 

8 Entsorgung 
 

Batterien dürfen aufgrund der enthaltenen Schadstoffe nicht in den Hausmüll entsorgt werden. Sie 
müssen an dafür eingerichtete Rücknahmestellen zu Entsorgung weitergegeben werden. 
 
Zur Umsetzung der ElektroG (Rücknahme und Entsorgung von Elektro- und Elektronikaltgeräten) 
nehmen wir unsere Geräte zurück. Sie werden entweder bei uns wiederverwertet oder über ein 
Recyclingunternehmen nach gesetzlicher Vorgabe entsorgt. 
 
 
Bei Fragen kontaktieren Sie bitte die PCE Deutschland GmbH. 
 
 

Eine Übersicht unserer Messtechnik finden Sie hier: http://www.warensortiment.de/messtechnik.htm 

Eine Übersicht unserer Messgeräte finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete.htm 

Eine Übersicht unserer Waagen finden Sie hier: http://www.warensortiment.de/messtechnik/messgeraete/waagen.htm 
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